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1 Harita Yap�m�  
 
Bu bölümdeki amaç, sunum için profesyonel kaliteli bir haritan�n nas�l olu� turulaca� �n� ö� renmek 
olacakt�r. Bu e� itim size ad�m ad�m jeolojik bir haritan�n üretilmesi, bir konum haritas�, lejant ve ba� l�k 
eklenerek  ç�kt� almaya haz�r bir hale getirilmesi i� lemlerini gösterecektir.  
 
Profesyonel Kaliteli Harita Üretimi 
 
Ad�m 1 – Harita Katmanlar�n�n Aç�lmas� 
 

1. MapInfo menü çubu� undan File>Open’� seçin. Discover_Tutorial\Map Making klasöründen 
GEOLOGY, STRUCTURES, MINERALS VE TENEMENTS dosyalar�n� aç�n. 

 
2. Enhanced Layer Control (ELC)’den her tablonun s�ras�n� kontrol edin ve � u s�rada 

gözükecek � ekilde düzenleyin: MINERALS, STRUCTURES, TENEMENTS ve GEOLOGY. 
 

3. ELC’den Zoom to all layer butonunu seçerek ya da Map>View Entire Layer>All Layers’� 
seçerek harita penceresi ayarlar�n�z� tamalay�n. 

 
Ad�m 2 – Çizgisel Yap�lara Sembol Eklemek 
 
STRUCTURES katman� syncline (ye� il çizgiler) ve anticline (kahverengi çizgiler) yap�lar�n�n her ikisini 
de içerir. Discover kullanarak, bu çizgiler kolayl�kla kendilerine ait k�vr�m aç� bilgilerini içerecek � ekilde 
modifiye edilebilir. 
 

4. STRUCTURES katman�n� editable yap�n ve anticline çizgi objesini seçin. Discover 
menüsünden Map Window>Select by Graphical Styles seçene� ini kullanarak 
STRUCTURES katman�ndan di� er tüm anticline çizgilerini seçin.  

 
5. Anticline bilgilerini içerecek � ekilde düzenleme yapmak için Discover>Map Making>Line 

Annotation diyalo� undan a� a� �daki seçenekleri i� aretleyin: 
 

 
 

Bilgiler STRUCTURES kataman�na yaz�l�r. Ayn� süreçleri bir Syncline sembolü ekleyerek syncline 
çizgileri için de tekrarlay�n. 

 
6. File>Save Table seçene� inden de� i� iklikleri STRUCTURES tablosuna kaydedin.  



Ad�m 3 – Metin Etiketleri Eklemek 
 
Discover haritan�z�n çizilmi�  oldu� u ölçekle ayn� ölçe� e sahip etiketler olu� turman�za olanak sa� lar.  
 

7. Text Labels diyalo� unu açmak için Text Labels butonuna klikleyin ya da Discover>Map 
Making>Add Text Labels secene� ini kullan�n. 

 

 
 

8. Text Labels diyalog kutusundan, Label objects from table listesinden TENEMENTS 
katman�n� seçin ve fFrom column listesinden Tenement alan�n� seçin. Save Labels to table 
listesinden New Table’� seçin ve tabloya ‘Tenement Text’ ismini verin. 
Discover_Tutorial\Map Making dosyas�n�n içine kaydedin. 1:15,000 lik bir harita ölçe� i için 
etiket boyutunu 10 pts olarak de� i� tirin ve OK butonuna bas�n. Yap�lar (tenement) her 
yap�n�n merkezine etiketlenecektir ve metinler Tenement Text katman�na kaydedilecektir.  

 
Ad�m 4 – Harita Lejant� Olu � turmak 
 
Katmanlar, kolonlar ve di� er tamamen ihtiyaca göre düzenlenen ki� isel lejantlarla Discover kullanarak 
bir al�� �lm��  lejant olu� turulabilir.  
 

9. Create Legend 2 diyalo� unu açmak için Legend butonuna klikleyin ya da Discover>Map 
Making>Create Map Legend yolonun izleyin.  

 
10. CTRL tu� una bas�l� tutarak MINERAL, STRUCTURES ve GEOLOLGY tablolar�n� seçin ve 

OK butununa klikleyin. 
 

11. Create Legend 2 dayalo� u size hangi öznitelik veri kolonlar�n�n lejantta görüntülenece� ini 
belirlemenize olanak sa� lar. Create Legend 2 diyalo� unu a� a� �daki gibi doldurun: 



 
 
12. Bu katmanlar için MINERAL ve GEOLOGY tablolar�n�n lejant s�ralar�n� ayarlamak için 

Specify Order kutular�n� klikleyin. E� er harita pencereniz tabloyu tam boyutunda 
görüntülemiyorsa ve tablodaki tüm objeler için bir lejant olu� turmak istiyorsan�z, Legend 
from objects in map window only kutusunu i� aretlemeyin. 

 
13. Lejant metni için font büyüklü� ünü ayarlamak için, Styles butonuna klikleyin ve Title 

Line’n�n yan�ndaki font style butonunu seçin. Nokta boyutunun 24 seçin. Sub-Title Line için 
süreci tekrarlay�n ve nokta boyutunu 14 seçin. Ok butununa iki kez klikleyin ve tabloyu 
Discover_Tutorial\Map Making klasörünün içine Geololgy ad�n� vererek kaydedin.  

 
14. MINERRALS katman� için lejant s�ra penceresi önce görüntülenecektir. Mineraller 

Alfabetik s�rada (artan) görüntülenmelidir, bu yüzden uygun seçene� ini seçin ve OK 
butonuna klikleyin. 

 
15. �kinci bir lejant s�ra penceresi GEOLOGY katman� için görüntülenecektir. Litolojiler 

kronolojik s�rada organize edilmelidir. Ya� lardan ziyade Litolojiler  görüntülenir. Discover 
ilk ayar diyalog kutusunda seçilmi�  olan ilk kolona göre lejant objelerini s�ralar.  
 
Alternatif olarak Look-up from Geology seçene� i nümerik bir öznitelik verisini kullanarak 
litolojinin s�ralanmas�na olanak sa� lar.  
 
Litolojileri kronolojik s�rada yerle� tirmek için gerekli yeniden düzenleme a� a� �daki 
diyalogta gösterilmi� tir. Cust�m ayarlar� kullan�n ve Up ve Dpwn butonlar�n� kulanarak 
objeleri hareket ettirin. Bitirdi� inizde OK butonuna bas�n. 



 
 

16. Jeolojik lejant yeni bir harita penceresinde görüntülenecektir. Jeoloji veri sayfas�n� 
görüntüleyerek litolojinin do� ru s�rda oldu� unu do� rulayabilirsiniz. 

 
Ad�m 5 – Ölçekli Ç�kt� Olu � turma 
 
Scaled Output arac� bir MapInfo ç�kt� penceresinde profesyonel görünü� lü bir harita ç�kt�s� üretebilir. 
Harita gridleri, ba� l�kbl�klar�, ölçek çubu� u ve lejant katmanlar� ölçekli ç�kt�ya eklenebilir.   
 

17. MapInfo Ç�kt� penceresinin boyutunun ayarland�� �ndan emin olun. MapInfo menü 
çubu� undan File>Page Setup yolunu izleyin, A3 seçin ve Landscape butonuna klikleyin. 
Sayfa ayarlar� parametrelerini kabul etmek için OK butonuna klikleyin.  

 
18. Scaled Output diyalo� unu açmak için Scaled Output butonuna klikleyin ya da 

Discover>Scaled Output yolunu izleyin. Map Scale alt�nda Custom Scale seçin ve 
görünen kutuya 15,000 yaz�n.  



 
 

19. Frame Setup alt�nda, Frame Settings listesinden New seçin. Görüntülenen çerçeve 
ayarlar� konfigürasyonlar� diyalog kutusunda, A4 seçin ve Landscape butonuna bas�n.  
 
Bu eksersiz için, harita objesinin d�� �na lejant ve bir ba� l�k blo� u ekleyeceksiniz. E� er A4 
boyutunda ka� �t seçtiyseniz, harita çerçeve pozisyonu geni� li� ini 5 cm azalt�n. 22.7 cm 
geni� li� e de� i� tirin. Çerçeve yüksekli� ini 19 cm b�rak�n.  
 

20. Scaled Output diyalo� una geri dönün, Draw Grid seçene� inin i� retli oldu� unda emin olun, 
Titleblk ba� l�k blo� u ismini temsil eder ve ScaleBar 1 ölçek çubu� u için listelenmi� tir. 
Ölçek çubuklar�n� 3 metrik ve 3 imperial ölçek çubu� unu içeren listeden seçebilirsiniz. OK 
butonuna bas�n. 

 

 
 
21. Harita penceresine yakla� acakt�r ve 1:15,000 ölçekli çizilmi�  alan� gösteren transparan bir 

poligon harita penceresinde görünecektir.   



Çerçevenin içinde farenin sol tu� una klikleyin ve tenement alan�n� ve geology kaplayan bir 
poligon çizin. 

 
22. Çerçeve pozisyonundan memnun oldu� unuzda Scaled Output>Accept map Position menü 

seçene� ini seçin. Harita penceresi transparan harita çerçevesi alan� yeniden boyutlan�r. 
Discover Map Grid diyalog kutusu görüntülenir. Varsay�lan parametrelerin kabul etmek için 
Ok butonuna klikleyin. Harita penceresinin içine bir grid çizilir. 

 
23. TitleBlock ve ScaleBar Seçenekleri fiyalog kutusunu aç�n. A� a� �daki ayr�nt�lar� girin: 

 
Title Line 1 : Tiger Snake Mining 
 
Title Line 2 : Geology Map 
 
Title Line 3 : Tenement Locations  
 
Author : (isminiz) 
 
Varsay�lan ba� l�k blo� u pozisyonu alt sa�  içtir. Titleblock Position listesinden, Bottom 
Right Outside seçin. Varsay�lan ScaleBar pozisyonu Show ScaleBar in Titleblock tur. 
Ölçek çubu� unu ayr� bir harita penceresinde de görüntüleyebilirsiniz ya da hiçbirinde 
görüntülemeyebilirsiniz. Other Options ç�kt�da ki harita penceresi katmanlar�n� listeleme 
olana� � verir. Varsay�lan görüntü pozisyonu Bottom Right t�r.  
 
Aç�k olan ölçekli haritay� içeren ve bir ç�kt� penceresi ve ba� l�k blo� u olu� turmak için OK 
butonuna bas�n. 

 
Ad�m 6 – Ç�kt�ya Ölçekli Lejant Çerçevesi Eklemek 
 

24. Geology lejant harita penceresini öne ta� �y�n. Add Scaled Frame butonuna klikleyin ya da 
Discover>Map Making>Add Scaled Farme to Layout  yolunu izleyin ve diyalog kutusunu 
a� a� �daki gibi doldurun.  

 

 
 
Lejant ç�kt� penceresine eklenir. Sayfa ölçüleri ç�kt� pencerisi boyunca cantimetre 
biriminde gözükür.  
 
A boyutunda sayfa için, Ofset from left alan�na 21.9 cm de� erini girin. Bir kez ç�kt�ya 
eklendikten sonra çerçevenin pozisyonunu daima ayarlayabilirsiniz.  

 
Ad�m 7 -  Konum Haritas� Olu � turma 
 
Son görevimiz ç�kt� penceresinin son haline bir konum haritas� eklemek olacak.   



25. ELC nin içinde sa�  fare tu� una klikleyin Open Table seçene� ini seçin. Open diyalo� unda 
Discover_Tutorial\Map Making klasöründen AUSTRALIA tablosunu seçin ve yeni bir harita 
penceresine ekleyin. (Prefferred View listesinden New Mapper � seçin) 

 
26. Sonra Australia!n�n içinde harita konumunu gösteren k�rm�z� bir dikdörtgen olu� turun. 

Discover>Object Editing>Key In Shapes menu seçene� ini seçin.  
 

27. Key in Shapes diyalo� unda Drow onto listesinden Cosmetic Layer � seçin. 
 

Rectangle obje tipini seçin ve Polygon obje sitili butonuna klikleyin. “N” (No pattern - 
� ablonsuz) seçene� ini seçin ve Line objesi sitiline klikleyin. Red çizgi rengini seçin ve 
geni� li� ini 2 piksel ayarlay�n. XY Units i decimal degrees olarak ayarlay�n. 
 
Enter Coordinates butonuna klikleyin. A� a� �da verilen XY koordinatlar�n� girin: 
 
Corner 1 X = 121.41 Y = -26.81 
 
Corner 2 X = 122.98 Y = -25.52 
 
OK butonuna ve ard�nda Exit butonuna bas�n.  
 

28. Map>Save Cosmetic Objects den yeni olu� turulmu�  dikdörtgeni ‘Location Area’ ad�nda bir 
tabloya Discover_Tutorial\Map Making klasörünün içine kaydedin. ELC diyalo� unda 
AUSTRALIA katman� için zoom arac�n� kullanarak tüm Australia katman�n� görüntüleyin. 

 
Ad�m 8 – Ç�kt� Penceresine Konum Haritas� Ekleme 
 

29. Location Area harita penceresini öne ta� �y�n. Map Making>Add Scaled Frame to Layout 
seçene� in seçin. Diyalog kutusunu a� a� �daki parametrelerle doldurun: 

 
Scale : 1:120,000,000 
 
Frame width : 5 cm 
 
Frame height : 4 cm 
 
Offset from left : 23.7 cm 
 
Ofset from top : 0.95 cm 
 
Map centre : 133.38o , -27.18o 
 
Konum haritas� ç�kt� penceresine eklenir. 

 
Ad�m 9 – Ölçekli Ç�kt�dan Ç�kmak ve Harita Çizmek 
 

30. Scaled Output>Exit Scaled Output seçene� ini seçin. 
 

Harita gridini, ba� l�k blo� unu, ölçek çubu� unu ve çal�� ma sayfas�n� (workspace) 
kaydetmenizi sa� layan bir diyalog kutusu gözükür. E� er daha sonra haritan�z�n daha fazla 
kopyalar�n� çizdirmek istiyorsan�z, tüm kutular� i � aretlemelisiniz ve ba� l�k blo� u, ölçek 
çubu� u ve harita giridini kaydetmek için tablo isimleri girmelisiniz. E� er tablolar� ve 
çal�� ma sayfas�n� kaydetmek istemiyorsan�z yeniden harita olu� turmak isterseniz ölçekli 
ç�kt� i� lemlerini tekrar yapmal�s�n�z.   

 
31. File>Print seçene� inden görüntülenen ölçekli haritay� yazd�r�n. Ba� l�k blo� u, lejant ve 

konum haritas� içeren bir örnek a� a� �da gösterilmektedir. 
 
 
 



 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 



2 Raster Görüntüyü Koordinatland�rma  
 
Bu e� itimin amac� bir raster görüntünün nas�l koordinatland�r�laca� �n� size göstermektir. E� er bir raster 
görüntü MapInfo’da File>Open dab aç�l�rsa, görüntü dünya koordinatlar�nda olmayan (non-earth 
coordinate) bir � ekilde görüntülenir. Bunun anlam� enlem/boylam ya da UTM gibi gerçek bir dünya 
koordinat�nda tutlan vektör veriyi kaplayamazs�n�z. Bri hava foto� raf� ya da taranm��  bir jeolojik harita 
gibi bir raster görüntüyü görüntülemek için görümtü gerçek bir dünya koordinat sistemine 
“koordinatland�r�lmal�d�r”. Böylece do� ru jo� rafi konumda görüntülenebilir.  
 
Raster görüntüler MapInfo ya da Discover kullan�larak koordinatland�r�labilir. Discover Images>Rectify 
Image arac� co� rafi gerçek-dünya koordinatlar�nda raster imajlar�n koordinatland�r�lmas�na izin veren 
kuvvetli bir özelliktir. MapInfo kullanarak görüntü koordinatland�rmadan farkl� olarak, Diccover Rectify 
Image arac� görüntüleri koordinatland�rabilir ve geni� letebilir, asimetri� ini alabilir ya da döndürerek 
görüntüleri modifiye edebilir. Bu süreç, Rectification ya da Rubber-Sheeting olarak bilinir. 
 
Bir raster görüntüyü koordinatland�rmak için gerçek dünya koordinatlar�n� bildi� imiz birkaç konuma 
ihtiyaç duyar�z. Bu konumlar kontrol noktalar� olarak adland�r�l�r. Bir görüntüyü koordinatland�rmak için 
en az 4 kontrol noktas�na ihtiyaç vard�r ve bu noktalar�n görüntü üzerinde düzgün da� �lmalar� 
gerekmektedir.  
 
Görüntüyü Dünyaya-Koordinatland�rma 
 
Ad�m 1 – Rectify Image Diyalo � unu Açma 
 

1. Discover ana menüsünden Images menü seçene� ini seçin. Yeni bir Images menüsü MapInfo 
menü çubu� una eklenir. Images menüsünden Rectify Image’� seçin. 

 

 
 
2. Load an image dosya butonuna klikleyin ve Discover_Tutorial\Register Image klasöründen 

REGIONAL_GEOLOGY.TIF dosyas�n� seçin. 
 
3. Loading Control Points diyalo� u gözüktü� ünde NO butonuna klikleyin. 

 



 
 

REGIONAL-GEOLOGY dosyas� Current Image (mevcut) penceresinde görüntülenmelidir ve 
görüntü bir harita penceresinde görüntülenebilir. 

 
4. Projection… butonuna klikleyin ve projeksiyonu Longitude/Latitude (AGD66) olarak de� i� tirin. 

 

 
 

Görüntümüze gerçek dünya koordinatlar� bilinen birkaç kontrol noktas� eklemeye ihtiyac�m�z 
oldu� unu biliyoruz. E� er taranm��  imaj bir harita gridine sahipse o zaman bu gridin kesi� imleri 
(kö� eleri) kontrol noktalar� olarak kunlan�labilir ve gerçek dünta koordinatlar� manuel olarak 
girilebilir.  
 
E� er görüntü üzerinde gözüken her hangi bir koordinat bilgisi yoksa, o zaman harita 
penceresindeki örne� in yol kesi� imleri, mülk s�n�rlar� yada drenaj noktalar� gibi vektör verilerden 
koordinat bilgileri al�nabilir. Ideal kontrol noktalar� tüm imaj boyuncu yay�lm��  olmal�d�r ve do� ru bir 
koordinatland�rma için çok say�da kontrol noktas� kullan�lmas� daha iyi olacakt�r. 
 
Ad�m 2 – Görüntüyü Koordinatlad�rma 
 
Hem harita penceresindeki imaj� hem de Rectify Image diyalo� unu aç�k bir � ekilde 
görebildi� inizden emin olun. REGIONAL_GEOLOGY harita penceresine klikleyin ve imaj�nsol üst 
kö� esine yakla� �n. Üst sol grid kesi� imini kullanarak ilk kontrol noktam�z� ekleyece� iz. Görüntü 
koordinatland�r�lmas�nda kontrol noktas� yerle � tirilirken kesinlik için iyice yakla� �lmal�d�r.  
 



 
 
5. Bir kontrol noktas� eklemek için New Point butonuna bas�n. Ground Control Points 

penceresine yeni bir çizgi eklenir. Bu sat�r� seçmek için Right Arrow ikonuna klikleyin. 
 

 
 
6. Seçilen kontrol noktas� sat�r�yla, Image butonuna klikleyin ve koordinatland�rmak için imleçi 

imaj� içeren harita penceresine götürün. �mleç art�k (+) � eklinde gözükecektir. Boylam� 118o ve 
Enlemi -22o olan imaj harita penceresinin üst sol kö� esindeki kontrol noktas� konumuna + 
klikleyin. Kontrol noktas� harita penceresine eklenir ve etiketlenir.  

 

 
 

Görüntüdeki X ve Y piksel koordinatlar�n�n konumlar� otomatik olarak kontrol noktalar� 
Image_X ve Image_Y hücrelerine güncellenir. 
 
Kontrol noktalar�n� kald�rmak için Delete Point butonunu kullan�n. Undo Change butonu 
kullan�larak yap�lan son de� i� iklik geri al�nabilir. 

 
7. Map_X ve Map_Y koordinatlar�n� düzenlemek için kontrol noktas� sat�r�n�n seçili oldu � undan 

emin olun. Seçili sat�r� i� aretlemek için sat�r�n sol taraf�ndan bir ikon gözükecektir. Map_X 
hücresine 118o ve Map_Y hücresine -22o girin. Not edelim ki bu örnekteki enlemler güney yar� 
küre için belirlenmi� tir.  



 
 

8. Öteki 3 kontrol noktas�n� eklemek için yukar�daki prosedürü izleyin: yani görüntünün üst sa� , 
alt sa�  ve alt sol kö� eleri için… 

 

 
 
9. E� er imaj üzerindeki kontrol noktas�n�n konumunu de� i� tirmeye ihtiyac�n�z varsa, harita 

penceresinde ki ImageControlPoints katman�n� düzenlenebilir (editable) yap�n, kontrol imleçi 
kullanarak kontrol noktas�n� yeni konumuna sürükleyin ve sonra Sync Map>GCP butonuna 
klikleyin. Yeni piksel koordinatlar�yla control noktas� Image_X ve Image_Y güncellenecektir.  

 
10. Tüm noktalar eklendi� inde Rectify butonuna klikleyin. Diyalogtaki gibi bir kay�t bir ç�kt� ismi ve 

konumu için yöneltecektir.varsay�lan olarak ç�kt� koordinatl� tablosu “rectified” son ekiyle 
birlikte orijinal imaj ismini içerecektir. Koordinatl� imaj� orijinal imajla ayn� klasörün içine 
kaydedin.  

 

 



Save butonunabas�ls�� �nda, rectify Image diyalo� unun üstünde koordinatland�rma i� lemini 
gösteren bir durum çubu� u görüntülenir. Koordinatland�rma i� lemi tamamland�� �nda 
koordinatl� görüntü yeni bir harita penceresinde görüntülenir.   
 

 
 
Bu koordinatl� imaj art�k jeolojik birimler ya da yap�sal veriler gibi çe� itli harita objelerini 
say�salla� t�rma için kullan�labilir. Nas�l say�salla � t�rma yap�laca� � veharita objelerinin nas�l 
renklendirilece� i hakk�nda daha fazla bilgi için Data Building e� itimine bak�n�z. 
 
Discover imajlarla çal�� �rken kullanmak için baz� ek araçlar içerir. Bunlar�n hepsi Images 
menüsünden bulunabilir: 
 

·  Reproject Image 
Raster imajlar� yeni bir koordinat sisteminde yeniden projeksiyonlar. 

 
·  Image Properties  

�maj projeksiyonu, X ve Y koordinat boyutlar�, sat�r ve kolonlar�n say�s�, toplam piksel, 
imaj tipi ve metadata’y� gösterir. 
 

·  Enhance Image 
�maj kontrat�n� ve parkal�� �n� ayarlar ve rengi ve gama K�rm�z�, Ye � il, Mavi kanallar�n� 
de� i� tirir. 

 
·  Fitler Image 

�maja yumu� atma (smoothing) ve kö� e bulma (edge detection) filtrelerini uygular. 
 

·  Clip Image 
Bir raster imaj� bir alana keser. 

 
·  Rotate Image 

Belirlenen bir aç�yla imaj� döndürür. 
 

·  Convert Image 
Varolan imaj� yeni bir iamj dosyas� format�nda kaydeder. 

 
Discover Images özelli� i sadece BMP, JPG, PNG, GIF ve TIFF raster imaj formatlar�yla 
uyumludur. 

 
 

 



3 Drillhole (Sondaj) Görüntüleme 
 
Bu e� itimin amac� Discover Drillhole modülünü kullanarak, bir do� u-bat� kesit serisi ve bir 
de� erlendirme raporunu kapsayan bir plan üretmektir. Bu istenen veri formatlar�n�, kesitlerin 
olu� turulma  süreçlerini ve bir kesit ç�kt�s�n�n nas�l üretilece� ini kapsar. 
 
Sondaj Kesitlerinin Görüntülenmesi ve Üretilmesi 
 
Veri Kaynaklar� 
 
Bu egzersizde kullan�lan örnek sondaj verileri (collor, survey, litholoji ve örnek veriler) basit bir Access 
veri taban�ndaki alanlara girilmi� tir. Ayn� analiz verisi bir Excel format�ndan dönü� türülmü� tür. Yüzey 
jeolojisi önceden say�salla� t�r�lm�� t�r ve MapInfo format�ndad�r. Bu veri seti toplam� 1585 m olan 11 
kuyundan meydana gelen ve bir alt�n aramas�nda yürütülen bir elmas sondajlama program�d�r. Bu 
dosyalar Discover_Tutorial\Drillholes klasöründe bulunmaktad�r. Bu dosyalar�n isimleri 
DRILLING.MDB, ASSAYS.XLS ve SURFACE_GEOLOGY.TAB d�r.  
 
Sondajlar� Görüntülemeden Önce Verinin Haz�rlanmas�  
 
Sondajlar� görüntülenmeden önce, veri a� a� �daki gibi haz�rlanmal�d�r: 
 

·  Excel format�ndaki assay verisi ile assay aral�klar�n� Access veritaban�nda birle� tirin 

·  Di� er Access tablolar�n� MapInfo’ya yükleyin. 

·  Collor konumlar�ndan objeler yarat�n 

·  Collor yüksekliklerinden bir dijital yükseklik modeli (DEM) yap�n 

 
Ad�m 1 – Örnek Verisini ve Assay Verisini Birle � tirme 
 

1. File>Open seçene� ini seçerek ve Files of type ’� Microsoft Excel olarak de� i� tirerek assay  
verisine ait Excel verisayfas�n� MapInfo da aç�n.  

 
Open seçene� ine bas�n. Use Row Above Selected Range for Column Titles kutusunu 
i� aretleyin. Disyalog art�k çal�� ma sayfas� aral�� �n� ‘Assay!A2:D318’ olarak görüntüler. Ok 
butonuna iki kez klikleyin. Bu veri taban�n�n içerdi� i SampNo, Au, As, Cu kolonlar�n� 
görüntüleyen bir veri penceresi aç�l�r.  
 

2. File>Open seçerek ve Files of type k�sm�n� Microsoft Access Database olarak 
de� i� tirerek örnek verileri içeren DRILLING.MDB Access veri taban�n aç�n. SAMPLES 
tablosunu i� aretleyin ve Ok butonuna bas�n. HolelD, From, To ve SampNo kolonlar�n� 
görüntüleyen bir veri sayfas� gözükür.  

 
3. SAMPLES tablosunun tablo yap�s�n� de� i� tirmelisiniz, bu yüzden assay bilgilerini ilave 

edebilirsiniz.  
 

Discover>Table>Maintenance>Table Structure>SAMPLES seçene� ini seçin. Float tipinde 
Au, As ve Cu alanlar�n� ekleyin. Ayr�ca, SampNo alan� için Index kutusunu i� aretleyin. Klik 
OK. Desteklenmeyen alanlar dikkate al�n�rken gözüken uyar� mesajlar�n�n hepsini iptal 
edin. Window>New Browser window komutundan SAMPLES tablosunu seçerek yeniden 
aç�n. 

 
4. � imdi assay de� erlerini SAMPLES tablosuna ekleyin. Discover>Table Utilities>Multiple 

Column Update seçene� ini seçin. Biz ASSAY (Get values from ) den alaca� �m�z 
de� erlerle SAMPLES (Update values in ) tablosunu güncellemek istiyoruz. 
Günecellenecek tablodaki SampNo ile eklenecek tablodaki SampNo alan�n� e� le� tirerek 
ekleme ko� ulunu tamamlay�n. Number of Column to update  seçene� ini 3 seçin ve klik 
OK. 
 



Kar� �n�za ç�kan bir sonraki diyalogta, Au, As ve Cu kolonlar�n�n her iki tabloya göre 
birle� tirildi� inden emin olun. OK butonuna bas�n. Assay bilgisi SAMPLES tablosuna 
eklenmi� tir. De� i� ikli� i daimi yapmak için File>Save Table menüsünü kullanarak tabloyu 
kaydedin. 
 
Assay veri tablosu art�k kapat�labilir. 
 

 
 
Ad�m 2 – Öteki Access Tablolar�n�n MapInfo da Aç�lm as� 

 
5. File>Open seçene� inden ve Files of type k�sm�n� Microsoft Access Database olarak 

de� i� tirerek MapInfo da COLLORS, SURVEYS ve LITHOLOGY tablolar�n� aç�n. Gelen 
diyalogta COLLORS, SURVEYS ve LITHOLOGY tablolar�n� seçin ve klik OK. 

 
 
Ad�m 3 – Collor Objeleri Olu � turmak 
 

6. MapInfo menü çubu� undan, Table>Create Points seçene� ini seçin. Diyalog kutusunda 
COLLORS tablosunu Create points for Table olarak ayarlay�n. Symbol butonuna klikleyin 
ve 8 point font büyüklü� ünde K�rm�z� içi dolu bir daire seçip klik OK. X-coordinate için 
Easting ve Y-coordinate için Northing girin. 

 

7.  Uygun AMG Zone’nunu seçmek için Projection butonuna klikleyin. Category 
alt�nda, Australian Map Grid (AGD 66) ‘y� seçin. Catogory Members alt�nda AMG Zone 
52(AGD 66) ‘y� seçin ve klik OK. Create Points penceresinde OK butonuna bas�n. 
Window>new Map Window komutundan art�k collors görüntülenebilir. 

 

 
 
 



 
 

Collors olu� turuldu� unda SURFACE_GEOLOGY tablosunu ayn� harita penceresinde aç�n. 
 
Ad�m 4 – Collor Yüksekliklerinden Bir Grid Yüzeyi O lu � turma 
 

8. bir kesit yüzey topo� rafyas�n� de� erlendirmek için tamamlay�c� bir ek topo� rafik yüzey 
kullan�labilir. Bir topo� rafik yüzey kullan�lmazsa, kom� u collor yüksekliklerinin birlikte 
kullan�lmas�yla yüzey topo� rafyas� ç�kar�l�r. 

 
E� er topo� rafik veri yoksa ya da bu örnekte oldu� u gibi collors yak�n konu� land�ysa, 
Discover dijital yükseklik modeli ve ili� kili konturlar� olu� turabilir. 

 
9. Discover>Surfaces menüsünü seçin. Menü çubu� una eklenen Surfaces menüsünden 

Surfaces>Crearte Grid seçene� ini seçin. 
 

Gridlenecek tanlo olarak COLLORS seçin ve OK butonuna klikleyin. 
 
Gridding diyalo� unda, Input sekmesinde Field alan�nda RL’yi seçin. Grid Geometry 
sekmesinden Cell Size de� erinin 2 oldu� undan emin olun. Method sekmesinde Gridding 
Method olarak Triangulation seçin. Output sekmesinde ç�kt� grid dosyas�na Surface_Grid 
ismini verip Geosoft (.GRD) format�nda Discover_Tutorial\Drillholes klasörünün içine 
kaydedin. Ok butonuna bas�n ve grid collors penceresine çizilir.  

 



 
 
Kesitlerin Olu � turulmas� 
 
Ad�m 5  - Discover Drillhole Projesi Sistemi 
 

10. Discover>Drillhole menüsünü seçin. Drillholes menüsi ampInfo menü bar�na eklenir. 
 

Drillholes>Project Setup’� seçin. New butonuna klikleyin ve drill rpjesi için örne� in “Drill 
Demo” gibi bir isim girin ve OK butonuna bas�n. Veriyi içeren klasörü seçin 
(Discover_Tutorial\Drillholes) ve a� a� �da gösterilen Project Definition dyalo� una uygun 
bilgileri girin.  
 

 E� er gerekliyse bu diyalogdan do� rudan yeni tablolar açabilirsiniz ve projeye 
ekleyebilirisiniz. Downhole tablolar�n� Available pencereden Selected penceresine 
ta� �mak için Right arrow butonunu kullan�n.  

 

 
 



11. OK butonuna kliklendi� inde, Assign Spatial Columns diyalo� u görünür. Kolonlar�n 
tamamen gerekti� i gibi e� le� ti� inden emin olun. E� er de� ilse, uygun kolonlar� e� le� tirmek 
için seçim listeleri kullan�n. Örnek veri seti collor e� imlerinin (dip) önünde negatif i� arete 
sahip de� ildir. O nedenle, Down Dip is negative seçene� ini seçmeden b�rak�n. Depth 
Units metredir.  

 
OK dedikten sonra Choose Project penceresinde yine OK diyerek kurulum prosedürünü 
tamamlay�n. 

 

 
 
12. Drillholes menüsünden, Section Manager diyalo� unu açmak için Section Manager 

seçene� ini seçin. Settings butonuna klikleyin ve Modify Project diyalo� unda Project Name 
k�sm�n� “Dri �� hole Tutorial” olarak de� i� tirin. Data Path (veri yolu) seçene� ini yeniden 
a� a� �daki gibi düzenleyin: 

 
C:\Documents and Settings\Tutorial Drillhole Project (ya da herhangi uygun dosya yolu) 

 

 
 

Copy Files to new location kutusunu i� aretleyin. Bu yeni klasör konumuna bütün proje 
dosyalar�n�n bir kopyas�n� olu � turacakt�r. Add New Sections to Section Manager kutusunu 
i� aretleyin. Her olu� turulan kesit ya da plan konumlardan birine kaydedilecektir. Create 
new Directory for each section seçene� ini seçin aksi taktirde bütün kesit ve plan dosyalar� 



proje klasörüne kaydedilecektir. Proje modifikasyonunuzu onaylamak için OK butonuna 
klikleyin ve diyalo� u kapatmak için Close butonuna bas�n. 

 
Ad�m 6 – Veritaban�n�z�n Onaylanmas� 
 

13. Drillholes>Validate Drillhole Database seçene� ini seçin. Diyalog kutusunda Validate all 
Drillholes seçene� ini seçin. OK butonuna klikleyin. 

 
Veri onaylama diyalo� u hangi kriterin onaylanaca� �n� kontrol etmenize ve tabloyu 
özelle� tirmenize izin verir. SAMPLES tablosunu seçin. Bütün seçeneklerin yan�na izin 
vermek için i� aret koyun. Duplicate sample numbers in column seçiminde kolonu SampNo 
olarak ayarlay�n. 
 
Output validation details to log file seçene� in seçin. Dosya ismi olarak ‘Results.txt’ 
girin. Save butonuna ve sonrada OK klikleyin.Onaylama sonuçlar� mesaj penceresinde de 
görüntülenir. 
 
Results.txt dosyas�n� WordPad de aç�n. Bu  veriyle ilgili hiç bir problem olmad�� �n� 
gösterir. E� er problem varsa, düzeltme yapmak için orijinal Access veritaban�na 
dönülmesi gerekli olabilir. 

 

 
 
Ad�m 7 – Bir Sondaj Plan�n�n Üretilmesi 

 
14. Collor harita penceresini aktif hale getirin. Harita penceresindeki tüm collars verisini seçin. 

Dirillhole>Define New Section or Plan seçene� in seçin. Drillhole Display seçenekleri 
alt�nda, Horizontal Plan’� seçin. Plot survey traces only kutusunu seçili b�rak�n ve Plan 
Demo gibi bir plan ismi girin. Plot Now seçene� ine klikleyin. 

 



 
 

Alternatif olarak, e� er kesin bir yükseklik aral�� �nda bir seviye plan� olu� turmak 
istiyorsan�z, Use elevation range seçene� ine klikleyin. Central elevation ve envelope width 
de� erlerini atay�n. E� er envelope witdh 10ve central elevation 35 seçilirse, sadece 54 ile 
25 metre yükseklik aras�ndaki sondaj görüntülenir.  
 
E� er downhole verisini bir plan kesiti üzerinde görüntülemek istiyorsan�z, plan Plot survey 
traces only kutusu i� aretlenmeden olu� turulmal�d�r. Downhole verisini görüntülemek için 
Ad�m 8 de kesitler için ana hatlar� çizilmi�  olan ayn� prosedürü izleyin. 

 
Ad�m 8 – Kesitte Kullanmak �çin Collors Seçilmesi 
 
Bir kesitte kullanmak için sondaj collarsseçilmesinde kullan�lan 3 metot vard�r: 
 

·  Easting (güney), northing (kuzey), line orientation (çizgi yönü)ve line lenght (çizgi uzunlu� u) 

için de� erler girin 

·  SHIFT tu� unu ve farenin sol butonunu kullanarak collors lar� seçin 

·  Kuyular boyunca bir çizgi çizin,çizgiyi seçin ve enevelope width de� erini de� i� tirin 

 

15.  Bu egzersiz için, üçüncü metodu kullan�n. Enchanced Layer Control 
penceresindeCosmetic Layer’� düzenlenebilir (editable) yap�n, MapInfo Drawing araç 
çubu� undan Line arac�n� seçin ve 3 collars’�n ortas� boyunca (Kuyular DDH1, DDH3 ve 
DDH4) soldan sa� a do� ru yatay bir çizgi çizin.  

 

  Çizdi� iniz çizgiyi seçin. Drillholes>Define New Section or Plan seçene� ini 
seçin. Hole Selection by control group da, Use selected line seçene� ini seçin.  

 
16. Envelope witdh dep� erini 10 m olarak de� i� tirin ve 0 derecelik bir View Direction seçin. 

Birkaç dou-bat� kesiti olu� turmak için, Multiple sections butonuna klikleyin ve Generate 
Multiple sections seçene� ini i� aretleyin. �ki kesit seçin, -10 m lik bir ofset verin ve Ok 
butonuna klikleyin. 

 



  Annotation butonuna klikleyin. Display Surface Line aç�k 
oldu� unda emin olun ve 1:1,000 lik bir ölçek için Label font size de� erini 6 olarak 
ayarlay�n. OK butonuna bas�n. 
 

 Kuzey yönünde 20 metrelik bir artmayla, üç kesit olu� turmak için Polt 
Now butonuna klikleyin. Not edelim ki, kesit zarf� (section envelope) Kozmetik katmana bir 
polygon harita objesi olarak eklenir. 

 
Ad�m 9 – Kesit Yöneticisi (Section Manager) 
 
Section Manager hem varolan sondaj kesitlerini açmak ve kapamak için  hem de aktif bir projeden 
kesitler eklemek ve silmek için yetenekler sa� lar. 
 

 
 
Drillhole>Section Manager seçene� ini seçin ve pencere varolan kesitleri ve onlar�n aç�k/kapal� 
durumlar�n� görüntüler.    
 
Ad�m 10 – Maksimum ve EOH De � erlerinin Ç�kart�lmas� 
 
Drillhole menüsünden bir sondaj projesindeki kuyulardan Maksimum ve EOH (End-of-Hole) 
de� erlerinin görüntülendi� i bir tablo olu� turmak mümkündür. 
 

17. Drillholes>calculate Maximum and EOH Values seçene� in seçin. Collar atblosu için 
COLLARS ve Downhole Verisi için SAMPLES seçin. Var olan alanlar�n listesinden, Au, As 
ve Cu seçin ve klik OK. Maksimum ve EOH de� erleri tablosunu MAXVALUE ismiyle 
Discover_Tutorial\Drillholes klasörüne kaydedin. 

 



 
 
Ad�m 11 – Kesitler �çin Görüntü Renk � ablonlar�n�n Düzenlenmesi 
 
Downhole verisini bir kesit üzerinde görüntülemeden önce, veri aral�lar�yla ilgili renk � ablonlar� 
üretmeniz gerekir. Bu örnek için, litoloji için bireysel (individual) bir � ablonu ve grade-shading Au text 
de� erleri için s�ralanm��  (ranged) bir renk � ablonu olu� turacaks�n�z.  
 

18. Drillholes>edit Colour Patterns seçene� ine klikleyin ve Legend Editor diyalo� unda New 
seçene� ini seçin.    

 
Varsay�lan olarak Samples_Au lejant ismi atan�r ki bu istenirse manuel olarak 
de� i� tirilebilir. Populate Legend from dataset kutusunu i� aretleyin ve Dataset listesinden 
SAMPLES seçin ve Field listesinde Au seçin. Say�sal bir Data Type seçin ve Number of 
rows’u 4 olarak ayarlay�n. 
 

 



 
Lejant, Legend Editor diyalo� unda görüntülendi� inde a� a� �daki aral�k detaylar�n� girin ve 
kaydedin: 

 

 
 
Range 1: from 0 to 1 , Fg renk mavi 
 
Range 2: from 1 to 3 , Fg renk ye� il 
 
Range 3: from 3 to 6 , Fg renk sar� 
 
Range 4: from 6 to 10 , Fg renk k�rm�z� 
 
LITHOLOJI için bir renk � ablonu olu� turmak için, yukar�daki prosedürü yeni (New) bir renk 
lejant� için tekrarlay�n ve bu sefer Dataset listesinden LITHOLOGY ve Field listesinden 
Rock seçin. Data Type olarak Text seçin ve bu lejanta Lithology_Rock ad�n� verin. Klik 
OK.  
 

 Lithology_Rock lejant� Legend Editor de görüntülendi� inde, her tek litolojik kay�t için 
bir renk/� ablon konbinasyonu seçmek için Fg (ön plan), Bg (arka plan) ve Patterns hücrelerine 
klikleyin. Tek � ablonlar� h�zl� bir � ekilde seçmek için, Patterns kolonunu seçin ve Step patterns 
butonuna bas�n. Kenar çizgi rengi, çzgi sitili ve kal�nl�� � da de� i� tirilebilir. 
 
Ad�m 12 – Sondaj Kesitlerine Notlar Eklenmesi 
 

19.  Drillholes>Dsiplay downhole data seçene� ini seçin. Maksimum 16 downhole de� i� keni 
çizilebilir. Kesitlere kaya (sondaj izinin merkezindeki iz gölgesi), sa� da metin olarak alt�n (Au) 
de� erleri ve sondaj izini solunda bir grafik çizgisi olarak arsenik (As) de� erleri ile notlar 
eklenebilir. 

 
 
  Kaya görüntüsünü düzenlemek için, Lithology tablosunu seçmek için tablo listesini kullan�n. Bir 

sonraki listeden kolon ismi olarak Rock seçin ve görüntü tipi listesinden Trace Shade seçin. 
 
 Varsay�lan parametreler bir Trace Shace penceresinde görünür. Litoloji renginizi seçmek için 

yukar�daki � emaya bak�n, Colour Pattern liste menüsüne klikleyin ve Lithology_Rock seçin. 
Di� er ayarlar� width 2 mm, scale 1:1000 ve ofset 0 mm olacak � ekilde de� i� tirin.  Klik OK. 



 
 

20. Au metin etiketlerini belirlemek için, diyalog kutusunun ikinci sat�r�nda Samples, Au ve Text 
bilgilerini atay�n. Text Labels diyalo� undan, Samples_au renk � ablonunu seçin ve 1:1000 
ölçe� i için 6 pt font boyutu girin. Görüntülemek için Position’� sondaj izinin 3 mm Near Right 
olarak ayarlay�n.  

 

 
 

21. Üçüncü hücre için Samples, As ve Linegraph ile prosedürü tekrarlay�n. Not eldim ki As 
de� erleri 20 ve 3900 ppm aras�nda de� i� ir. Verilen geni�  veri aral�� �ndan dolay�, do� ru bir 
ölçek ayarlaman�z gerekmektedir. 1:1000 lik harita ölçe� i için ölçe� i 0.02 olarak ayarlay�n. 
E� er yüksek bir de� er kullan�rsan�z, daha küçük bir de� er seçmenizi tavsiye den bir uyar� 
mesaj� görüntülenir. Line Style butonuna basarak ve k�rm�z�y� seçerek çizgi rengini k�rm�z� 
olarak de� i� tirin. Position’u linegraph, sondaj izinin sol taraf� (left side) ve 1 mm lik bir ofset 
seçip klik OK. 



 
 

22. Diyalo� un üstündeki Save butonuna  basarak bu mevcut veri görüntüleme ayarlar�n� kaydedin. 
Ayarlar� Drill Demo ad�n� vererek kaydedin. Bu ayar  gelecekte, kesitlerin ba� lant�l� bir veri 
olarak görüntülenmesinin sa� lanmas� için kullan�labilir.  

 

 
 

23. Notlar� görüntülemek için Data Legend seçene� ini seçin böylece ranged ve individual renk 
� ablonlar� bir anahtar olarak görüntülenir. 

 
Apply butonuna klikleyin ve Apply to Section kutusunda olu� turulmu�  2 dikey kesiti seçin. OK 
butonuna klikleyin. Seçilen dowkhole verisi üç kesitin üstüne çizilir. 

 
Ad�m 13 (opsiyonel) – Önceden Olu � turulmu �  Kesitlerin Kullan�lmas� 
 
Yeni olu� turdu� unuz kesitler drillhole section Manager ile kaydedildi. Section Manager önceden 
olu� turulan kesitlerin ça� r�lmas�na izin verir ve onlar� bir listeden açar. E� er öneceden kesitlerinizi 
Section Manager ile saklanmalar� için ayarlamad�ysan�z, bunu � imdi ayapabilirsiniz. 
 

24. Drilllholes>Section Manager seçene� ini seçin. Add butonuna klikleyin, bir kesiti eklemek için 
seçin ve OK butonuna klikleyin.   �� lemi di� er kesitleri eklemek için tekrarlay�n. 

 
Ad�m 14 – Bir Log Görüntüsünün Üretilmesi 
 
Log görüntülemesi, bireysel sondajlar için çoklu kolonlar�n ayr�nt�l� bilgilerini kolay bir � ekilde 
görüntülemek için kullan�l�r. 24 ve üstü farkl� kolon bilgisini bir sondaj için bir log da görüntüleyebilir. Bu 
özellikle özel litolojik bir s�n�r boyunca çoklu-element göçünü ayr�nt�l� bir � ekilde sorgulanmas� için 
kullan�� l�d�r.  
 

25. Log görüntüsü elde etmek için harita penceresinde sondaj collar konumuna dönün. Bir sondaj 
seçin, örne� in DDH3. Log Display butonuna bas�n ya da Drillhole>Log Display menü yolunu 
izleyin. 



26. Drillhole Log Dsiplay diyalo� undan, Select Columns from Data Table listesinden LITHOLOGY 
tablosunu seçin. � imdi Available Columns penceresinden Rock kolonunu seçin ve Columns to 
Log  in Log dialog butonuna klikleyin. 

 

 
 

27. Bu diyalog için log görüntü ayarlar�n� seçmek için Settings butonuna klikleyin. Log Type olarak 
Trace Shade ve Colour  Pattern olarak da Lithology_Rock seçin ve iki kez OK butonuna 
klikleyin. 

 

 
 

28. SAMPLES tablosunu, Au, As ve Cu kolonlar�n� seçin. Setting butonunu klikleyin ve log type 
olarak Linegraph ve çizgi grafiklerinin özel olarak belirlenen ltoloji loglar�yla doldurmak için  Fill 
from Tarce Shade seçene� ini seçin. Di� er ayarlar� b�rak�n ve iki lez Ok butonuna klikleyin. 

 
Log için seçilen 4 kolon art�k ana diyalogta listelenir. Settings butonuna klikleyerek bu kolonlar için 
ayarlar bireysel olarak de� i� tirilebilir. Bu log görüntü ayar�n� kaydedebilirsiniz, böylelikle daha sonra 
yeniden kullanabilirsiniz.  
 
Global Setting butonu global boyutlar�, görüntü sitillerini ve veri i� lemeyi içeren baz� varsay�lanlar� 
de� i� tirmenize olanak verir. Bu ayarlar�n birço� u her kolon içinde de� i� tirilebilir.  
 



29. OK butonuna klikleyin ve Discover her kolon için sondaj loglar� olu� turur. E� er birden fazla 
sondaj seçtiyseniz, her sondaj için bir log ayr� birer tabloda olu� turulacakt�r. 

 

 
 
Ad�m 15 – Ekran-Üstünde Yorumlama 
 
Mineralizasyon ya da litolojik s�n�rlar�n jeolojik yorumlar� olu� turulmu�  kesitlerden ekran üstünde 
say�salla� t�r�labilir.  
 

30. Drillholes>Boundaru Digitising>Digitise Boundariees konutunu izleyin ve olu� turulmu�  
kesitlerden birini seçin. Discover say�salla� t�rma bilgilerini saklamak için otomatik olarak bir 
tablo olu� turur. Tablo <section_name>_B ismine sahiptir ve otomatik olarak kesit penceresine 
eklenir ve düzenlenebilir yap�l�r.  

 
Her tip obje say�salla� t�r�labilir. Bu egzersiz için, litolojik s�n�rlar ya da yüksek-dereceli Au 
cevher  kabuklar� say�salla� t�r�lacak. MapInfo Drawing araç çubu� undaki Region Style 
butonundan, uygun bir renk seçin. Sonra Polygon butonunu seçerek, yorumlanm��  cevher 
bölgelerini say�salla� t�rmaya geçebilirisiniz.  
 
Her cevher poligonu kapand�ktan sonra, veri penceresindeki Feature_Code kolonuna öznitelik 
verilerini eklemeniz gerekir. Alternatif olarak, öznitelik verileri için Information Tool kullan�n. 
E� er ihtiyaç duyulursa bu tabloya ilave alanlar eklenebilir.   
 
Orta ve dü� ük seviyeli mineralizasyon için ekran üstünde yorumlamaya devam edebilirsiniz. 
Düzenli bir temel üstünde File>Save Table kullanmay� hat�rlay�n. 

  



 
 

Ar bir kez s�n�rlar say�salla� t�r�ld�� �nda, di� er bir yaz�l�m paketinde kullanmak için 3D DXF koordinatlar� 
export (içeri aktar�m) edilebilir. Drillhole>Boundary Digitising>Export Boundaries. 
 
Ad�m 16 – Kesitsel Kaynaklar�n Üretilmesi 
 
Kaynak hesplay�c� her say�sal downhole verisi için bir kesit kayna� � üretmek için  Ters Uzakl�k A� �rl�kl� 
Enterpolasyon (IDW) yöntemini kullan�r.  
 

31. Kesitsel bir kaynak üretmek için, yukar�da üretilen baz� mineralizasyon s�n�rlar� için 
say�salla� t�rd�� �n�z kesitlerden birini kullanman�z gerekir. Drillhole>Section Resourse 
Calculator menü seçene� ine klikleyin. 

 
Varolan kesitlerden birini seçin ve OK butonuna klikleyin. From table listesinden Samples 
tablosunu seçin. From column kutusundan Au seçin ve OK butonunu seçin. Say�salla� t�r�lm��  
s�n�rlar� kullanmak için seçenek seçin ve Clip to boundary with attributes seçene� inden 
Feature Code öznitelik poligonlar�ndan birini seçin. Store Resourse in column seçene� ini 
i� aretleyin ve resourse seçip, klik OK. 
 
Grid varsay�lanlar�n� kabul etmek için Gridding Section penceresinde Ok butonunu seçin. 
Kesitsel kaynak i� lenecek ve görüntülenecektir. 
 



 
 

Ad�m 17 – Dowhole Öznitelik Verisinin Bile � tirilmesi 
 
Alanlar� birle� tiren Discover verisi öznitelik, kesik s�n�f. Yükseklik ya da dowhole derinli� iyle dowhole 
özniteli� inin birle� tirilmesine olanak verin, örne� in litololjik birime göre ya da 10m aral�lardaki sondaj 
kuyular�ndaki birle� ik assay verisi. 
 

32. Drillholes>Downhole Compositing ‘in seçilmesiyle downhole derinli� ini birle� tirebilirsiniz. 
Composite using downhole table olaraka SAMPLES seçin ve Elevation sekmesi ve Downhole 
Dept seçenene� ini takip edin. Diyalo� un sol taraf�nda DDH5 ve DDH6 kuyular�n� seçin. 
Downhole tablet o composite olarak SAMPLES seçin. �ki kez OK butonuna bas�n. Gözüken 
diyalog kutusunda 10m lik bir composite interval seçin ve SAMPLES tablosunu i� aretleyin. 
�� leme ba� lamak için Ok butonuna klikleyin.  

 



 
 
�� lem tamamland�� �nda, Samples_comp için yeni bir veri penceresi açarak sonuçlar� 
gözlemleyebilirisiniz. Bu birle� ik veri art�k di� er tüm downhole veri tablolar� gibi kesitte 
görüntülenebilir, otomatik olarak projeye eklenemsi için Add output to current Project seçene� ini 
i� aretleyin. 
 
Di� er birle� tirme metotlar�n� da kullanarak tecrübe kazanabilirsiniz.  
 
Ad�m 18 – Bir Kesit Gridini Görüntülenmesi 
 
33. Kesite bi r harita gridi eklemek için, bir kesit penceresini en öndeki harita penceresi yap�n ve 

Drillholes>Draw Section Grid seçene� ini seçin ya da Section Grid butonuna klikleyin.Grid 
mevcut harita penceresi görüntüsünü dolduracak � ekilde çizilecektir. Alternatif olarak, Add 
Section to Layput menü seçene� i kullan�larak bir kesit gridi otomatik olarak eklenebilir.  

 
34. Drillholes>Draw Section Grid seçene� ini seçin. X ve Elevation aral�� � birbirinden ba� �ms�z 

olarak özelle� tirilebilir. X-value olarak 25 m ve elevation olarak 20 m seçin. Grid çizgilerinin ve 
sol-üstteki etiketlerin varsay�lan parametrelerini kullan�n  ve place labels in mask polygon 
outside map frame kutusunun i� aretli oldu� undan emin olun. Klik OK. 

 
E� er grid pozisyonunu kesite göre ayarlamazsan�z,  kesiti ta� �yabilir ve grid i� lemini yineleyebilirisiniz. 
E� er siz kesit gridinin olu� turuldu� u varsay�lan tablo ismini de� i� tirmezseniz, önceki kesit gridinin 
üstüne yaz�l�r. 
 



 
 
Ad�m 19 – Bir Sondaj Kesitinin Formatlanmas� ve Yaz d�r�lmas� 
 
A3 boyunda bir kesit ç�kt�s� almak için a� a� �daki prosedürü izleyin. 
 

35. Section Layput butonuna klikleyin ya da Drillholes>Add Section to Layout yolunu izleyin. 
 

 
 

36. Görüntülenen diyalogta ç�kt� penceresine eklemek için kesiti seçin. Map Sacle listesinden 
1:500 ve frame Setup listesinden A4 Landscape seçip klik OK. Bir Hairta Boyutu Dikdörtgeni 
seçili kesit penceresine eklenir. Bu dikdörtgenin pozisyonu harita penceresindeki kesit verisinin 
üstündedir. 

 



E� er harita ölçe� ini ya da çerçeve boyutunu de� i� tirmek isterseniz, mapInfo manü çubu� una 
eklenmi�  olan Section Output menüsünden Re-Specify Parameters seçene� ini seçin. 
�stedi� iniz Harita Boyutu pozisyonunu buldu� unuzda, Section Output menüsünden Accept Map 
Position seçene� ini seçin. 

 
37. �kinci Add Section to Layout diyalo� unda, Add Plan of Collors to Layout kutusunu i� aretleyin. 

Bu yukar�da ilgili kesitlere göre çizilmi�  olan collor posizyonlar�yla bir harita üretecektir ve 
yüzey jeoloji poligonlar�n� içerecektir.  

 
Harita penceresi görüntüsünü yenilemek için Preview butonuna klikleyin. Seçilen kesit(lerin) 
ç�kt� penceresine eklendi� inden emin olun ve listelerden Titleblk ve Sacelebar 1 seçin. Ok 
butonuna klikleyin. Drillhole Section grid diyalo� unda 25 m lik bir X-value ve 20 m lik bir 
elevation seçin. Sol üstteki etiketler ve grid çizgileri için varsay�lan parametreleri kullan�n ve 
Place labels in mask polygon outside map frame kutusunun i� aretlendi� inden emin olun. Klik 
Ok. 
 
TitleBlock ve ScaleBar Options diyalo� u görüntülenir. Author olarak isminizi girin ve TitleBlock 
position olarak Bottom Right Outside seçin. Other Options sekmesi alt�nda Display list of 
Layers harita listesinden No List seçene� ini seçin. Layout penecersini görüntülemek için Ok 
butonuna klikleyin. 
 
Kesiti içeren bir ç�kt� penceresi görüntülenir. Collor Plan otomatik olarak kesitin üstüne eklenir. 
Ç�kt� üzerinde bir çerçeve objesi çizerek ç�kt� penceresine XSectLeg ekleyebilirsiniz ve bu 
XSectLeg penceresini içerine göre özelle� tirebilirisiniz.  

 

 
 
38. MapInfo File>Page Setup menü seçene� inden yaz�c�n�z ve A3 Landscape sayfa boyutunu 

seçin. 
 

Sonuç ç�kt�s�n� bir workspace olarak kaydedin ve kesit ç�kt�s�n� yaz�c�n�za yollamak için 
MapInfo File>Print menü seçene� ini kullan�n. 

 



4  Grid Yüzey Olu � turma  
 
Bu e� itim size Discover da grid yüzeylerinin ve kontur planlar�n�n nas�l olu� turuldu� unu ve 
kullan�ld�� � gösterir. Veri kayna� � olarak nokta yüksekliklerini içeren bir topo� rafik veri seti 
kullanaca� �z. 
 
Yüzey Medelleme ve Analizi �çin Bir Örnek 
 
SPOT HEIGHTS ad�ndaki bir nokta yükseklik serisi olarak depolanan yükseklik verisi 
Discover_Tutorial\Surfaces klasöründe bulunmaktad�r. Bu e� itimin amaçlar�; bir grid yüzeyi 
enterpole etmek ve bir kontur plan� üretmek, bir profil olu� turmak, grid e� imini ve bak�s�n� 
belirlemek, gölgelendir (sun-shading) yapmak ve bir gridi bir alana kesmektir.  
 
Ad�m 1 -  Grid �� leyiciyi (Grid Handler) Yap�land�rmak  
 
Discover yayg�n olarak kullan�lan 3 fortmatta grid yüzeyleri olu� turabilir : Geosoft.*GRD, ER 
Mapper *.ERS ve Surfer.*GRD. Bu formatta üretilen gridlerden ba� ka, Discover a� a� �da belirtilmi�  
olan di� er gridleme yaz�l�m uygulamalr�nda olu� turulmu�  gridleri de import (içeri aktar�m) edebilir: 
 

·  Geosoft 

·  ER Mapper 

·  Surfer 

·  Vertical Mapper 

·  ESRI ASCII 

·  Di� er ASCII gridleri 

·  USGSDEM 

·  Minex 

·  BIL 

 
Discover>Configuration>Grid Handlers ve a� a� �daki grid i� leyicilerini listelendi� inden emin olun. Use 
MapInfo Grid Handlers (olas� olan) kutusunu i� aretleyin ve varsay�lan ç�kt� grid tipi olarak ERMapper, 
Geosoft ya da Surfer giridden birini i� aretleyin. Yeni bir grid olu� turuldu� unda varsay�lan ç�kt� grid tipi 
üstüne yaz�labilir. Klik OK. 
 

 
 
 
 



Ad�m 2 – Bir Yüzey Gridi Olu � turmak 
 
SPOT HEIGHTS tablosunu aç�n. Map>View Entire Layer seçene� ini seçin. Discover menüsünden, 
Surface menuüsünü seçin. Surface menüsü MapInfo menü çubu� una eklenir.  
 
Surface>Create Grid… seçene� ini seçin. SPOT HEIGHTS tablosunu gridlemek için seçin ve OK 
butonuna klikleyin. Not edelim ki, e� er görüntülenen veri noktalar�n�n sadece bir k�sm� ya da altkümesi 
gridlenecekse, diyalog listesinde ilave bir Selection seçene� i görünür.  
 

 
 
Gridding Tool, bir yüzey gridi olu� turmak için grid parametreleri ayarlar�n� içeren bir seri tab 
diyalo� undan meydana gelir.  Her diyalog kutusuna e� lik eden gridin olu� turuldu� unda nas�l 
gözükece� ini gösteren bir ön görüntü penceresi vard�r.  
 

 
 

  Gridding diyalo� unun Input (giri� ) sekmesinde, gridleme için gözüken listeden Elevation’� 
seçin. �maj diyalo� un sa�  taraf�nda görünür. Grid ön izlemesinin üstünde 6 buton ve bir çekme listesi 
bulunur. Bu butonlar giridn Preview penceresindeki görüntü özelliklerini kontrol eder. Apply histogram 
equalisation butonunun seçili oldu� undan emin olun ve colour table listesinden pseudocolor seçene� in 
seçin.  
 
Aç�l�r menüyü görüntülemek için ön görüntü penecersi üzerinde sa�  fare tu� una klikleyin : 
 



 
 
Görüntülenen her grid hücresini görmek için Show Value at Cursor seçene� ini i� aretleyin. 
 

 Bu buton girdi veri noktalar�n� ön izleme penceresinde görüntüler. 
 

 Bu buton renklendirilmi�  ya da griskalal� bir grid aras�nda gidip gelmenizi sa� lar. 
 

 Bu butonu otomatik gölgelendirmeye dönmek için seçin. 
 

 Bu butonu, girdi veri istatistiklerini bir histogram da� �l�m� ya da grafiksel formatta görüntülemek 
için kullan�n. Statistical Explorer tek de� i� kenli, iki de� i� kenli, mekansal ve variogram istatistik 
metodlar�n� kullanarak girdi grid verilerini görüntüleyebilir. 
 

 
 



Method sekmesinde, Method’u Triangulation olarak ayarlay�n. Gridleme metotlar�, girdi veri 
noktalar�ndan ve aralar�ndaki grid hücreleri için enterpole de� erleri görmede farkl� algoritmalar 
kullanmay� sa� lar. Triangulation bütün veri noktalar� aras�nda üçgenler olu� turan düzensiz üçgenleme 
(Delaunay triangulation) metodunu kullan�r. Grid hücre de� erleri her grid hücresini bulundu� u üçgenle 
ayn� düzlemdeki de� erlere atan�r. Bu gridleme metodu, mümkün olan en do� ru orijinal veri girdi 
noktalar�n� kabul etmeye ihtiyaç duyan veri setlerini için en uygunudur: örne� in yükseklik verisi. 
 
Jeokimyasal veriler gibi di� er tip veri setleri, Minimum Curvature ya da Inverse Distance Weighting gibi 
di� er enterpolasyon metotlar� kullan�larak gridlenebilir.  
 
Grid Geometry sekmesi e� er gerekliyse grid hücre boyutlar�n� manuel olarak de� i� tirebilmenizi sa� lar. 
Gridlenecek olan verinin boyutu da Data Coverage seçenekleri alt�nda düzenlenebilir. 
 
Output sekmesinde gridi Geosoft format�nda [.GRD] ve TOPO_GRID.TAB ismiyle kaydedin. OK 
butonuna klikleyin ve Discover gridi kaydedecek ve yeni bir harita penceresinde ya da SPOT 
HEIGHTS verisini içeren harita penceresinde açacakt�r. 
 
Ad�m 3 – Yükseklik Gridinden Kontur Olu � turma 
 
Surfaces>Contour a Grid seçene� ini seçin ve Contour a Grid diyalo� unu görüntüleyin. Grid to contour 
(konturlanacak grid) olarak TOPO_GRID tablosunu seçin. Contour Smoothing kutusunu ve Specify 
minimum/maximum values to contour between kutusunu i� aretleyin ve aral�� � 0 ve 1200 olarak 
b�rak�n. Output Contour Table butonuna klikleyin ve tabloyu GRID_CONTOURS ad�yla 
Discover_Tutorial\Surfaces klasörünün içine kaydedin. 
 
Klik OK ve Discover yeni kontur çizgilerini TOPO_GRID harita penceresine ekler. Konturlerinize kontur 
etiketi eklemek için Surfaces>Label Contour L�nes menüsü seçene� ini kullanabilirsiniz. 
 
Bu egzersizi tamamlamak için GRID CONTOUR tablosunu kapat�n. 
 

 
 
Ad�m 4 – Grid Renklerini, Gölgelendirmesini ve Tran sparanl� � �n� De� i� tirmek 
 
Yukar�daki TOPO GRID katman� bir Pseudocolour renk � emas� kullan�larak görüntülenmi� tir. Bir grid 
ilk olu� turuldu� unda ya da import edildi� inde giride uygulanm��  olan renk � emas�n�n de� i� tirilmesi 
mümkündür. Gerçek zamanl� gölgelendirme (sun-shading) uygulanmas�yla grid rengi bir yükseklik 
renk � emas�na de� i� tirilecektir.  
 



 
 
Grid rengini de� i� tirmek için, Surface>Modify Grid Display seçene� ini seçin. Colour sekmesinde Full 
Linear Strerch metodunu seçin ve Select Colour table listesinden ELEVATION renk � emas� seçin. 
Gridi maviden (en alçak) kahverengi ve beyaza (en yüksek) do� ru de� i� en renklerle görüntülemek için 
Apply butonuna bas�n.  
 
Full Linear Stretch renk metodu renk � ablonunu minimum ve maksimum grid hücre de� erleri aras�nda 
lineer olarak uygular. Her renkte görüntülenen grid hücrelerinin yakla� �k olarak e� it olan say�lar�n� 
görmek için Histogram Equalisation metodunu uygulay�n.  
 
Ayn� diyalogda, Autoclip (otomatik kesme) lineer germe gibi çe� itli grid renklendirme formu 
seçeneklerine sahipsiniz.  
 
Histogram format�nda grid hücre de� eri renklerini görüntülemek için Histogram sekmesini seçin.  
 

 
 



Transparency kutusunu i� aretlemek için Colour sekmesine dönün ve sürgüyü %20 olarak ayarlay�n. 
Bu bir sonraki egzersizde kaplanm��  jeoloji verisini görüntülememizde yard�mc� olacak.   
 

  Sun sekmesine klikleyin. Sun Shade kutusunu i� aretleyin. 60o lik bir  yükseklikle aç�y� (Angle) 
70o olarak ayarlay�n. Grid penceresindeki de� i� iklikleri görmek için Auto Apply kutusunu i� aretleyin ya 
da Apply butonuna klikleyin. Ayr�ca Sun Highlight kutusunu i� aretleyerek ikinci bir �� �k kayna� � 
uygulayabilirsiniz. Bu özellik gridlenmi�  jeofizikselveriyi görüntülerken çok kullan�� l�d�r. Alternatif olarak 
Sun sekme öz izleme penceresine klikleyebilir ve manuel olarak Sun Shade ya da Sun Highlight 
kaynaklar�n� yeni bir konuma sürükleyebilirsiniz.  
 
Bir grid lejant� görüntülemek için Surfaces>Create Grid Legend menü seçene� ini seçin.  
 
Ad�m 5 – Bir Griden Profil Olu � turulmas� 
 
Discover _Tutorial|\Surfaces klasöründen GEOLOGY tablosunu aç�n. Bu tablo jeofiziksel birimlerde 
sunulan renklendirilmi�  poligonlar� içerir. ELC (Geli� tirilmi�  Katman Kontrolü) penceresinde GEOLOGY 
katman�n� TOPO GRID katman�n alt�na ta � �y�n. Grid Alt�ndaki jeoloji alnlar�n� görüntüleyeb ilmek için 
grid tarnsparanl�� �n� açmal�s�n�z. Katmanlar� yeniden s�ralamay� biti rdi� inizde art�k GEOLOGY 
katman� gridin üstünde olmal�d�r.  
 
Bir yüzey profili olu� turuldu� unda, yüzey çizgisi kesit görünümünde görüntülenir. Profil çizgisinin 
GEOLOGY tablosunda kesi� en poligonlara göre kaplanmas�yla renklendirilmesi de mümkündür.   
 
ELC’den Kozmetik Katman� (Cosmetic Layer) düzemlenebilir (editable) yap�n ve mapInfo Drawing 
(çizim) araççubu� undan seçilen Line (çizgi) arac�yla imaj�n merkezi boyunca soldan sa� a do� ru bir 
çizgi çizin. Harita penceresinde çizgiyi seçin.  
 

 
   

  Surfaces>Draw Grid Profile butonunu seçin ve a� a� �daki diyalogda gösterildi� i gibi bilgileri 
girin. Profili olu� turmak için OK butonuna klikleyin. 

  
 
 
 
 
 
 
 



 
 
Profili içeren bir harita penceresi aç�l�r. Vertical Exahheration kullanarak ya da Smoothed Profile 
kutusundaki seçimi kald�rarak egzersizi tekrarlamal�s�n�z ve farklar� görmelisiniz.  Profilinizi kaydetmek 
istiyorsan�z, Save As butonuna klikleyin ve uygun bir tablo ismi seçin.  Yoksa geçici tablo profilinin 
daima üstüne yaz�lacakt�r.  
 

 
 
Poligon kaplama parametrelerinin (polygon drape parameters) girilmesi gerekli de� ildir. Bo�  
b�rak�l�rsa, yüzey profilini simgeleyen kesintisiz siyah bir çizgi çizilir. Bununla beraber, profille kesi� en 
jeolojinin, yap�lar�n yada ye� illi� in incelenmesi için poligon kaplama özelli� i (polygon drape option) 
kullan�� l�d�r.  Harita penceresindeki uygun katmanlarla Show intersections in profile for all 
selectable line/polyline layers in the map window  kutusunun i� aretlenmesiyle yol yada dere 
kesi� imleri de  profilde görüntülenebilir.  
 



GEOLOGY ve PROFILE tablolar�n� kapatarak ve kozmetik katman objelerini silerek egzersizi 
tamamlay�n.  
 
Ad�m 6 – Griden De � erlerin Tayin Edilmesi 
 
Bir vektör katman�ndaki harita objesine grid hücre de� erlerini atamak mümkündür. Bu özellik jeolojik 
bölgelere dayand�r�lan jeolojik verileri toplamak ya da sondaj (drillhole) ya da örnek verilerine  
yükseklik ya da RL de� erlerini atamak için kullan�labilir.  
 
Discover_Tutorial\Surfaces klasöründeki STREAM SAMPLES tablosunu aç�n. Veriyi tablo format�nda 
görüntüleyin ve bo�  RL kolonuna dikkat edin. TOPO GRID den al�nan RL de� erleriyle tabloyu 
güncellemek için, harita penceresindeki tüm akarsu örneklerini seçin ve Surfaces>Assign Values from 
Grid menü seçene� ini seçin.  
 
Assign value to column listesinden RL’yi seçin ve OK butonuna klikleyin. RL de� erleri, tabloda bulunan 
ve girilen her akarsu örne� indeki grid hücrelerinden otomatik olarak al�n�r. Bu güncellemleri kaydetmek 
için File>Save Table seçene� ini seçin.  
 
Grid hücreleri poligon verisine atand�� �nda, her poligona dü� en bütün grid de� erleri için ortalama, 
minimum ya da maksimum de� erler belirlenebilir.  
 
Ad�m 7 – Grid Sorgular� 
 
Surfaces modülü, özel kriterlere uygun grid parçalar�n� seçmenize izin veren güçlü bir grid analizi arac� 
içerir. Belirtilen kritere uygun grid hücreleri yeni bir katmana poligon olarak kaydedilir. Grid hücreleri 
gerçek grid hücre de� erlerine göre ya da bütün veri setinin yüzde birlik aral�� �yla seçilir.  
 
Surfaces>Grid Query>Select by Multiple Ranges  seçene� in seçin. Diyalog kutusunda, Value’yu 
seçin ve Levels penceresine � u de� erleri girin : 200, 400, 600, 800, 1000 ve 1200. Her de� erin 
yan�ndaki Colour hücresine klikleyin ve görüntülenen renk paletinden renk seçin.  
 
Varsay�lan Output (ç�kt�) dosya ismini ve konumunu oldu� u gibi b�rak�p OK butonuna klikleyin.    
 

 
 
Di� er sorgu parametreleriyle de denemeler yap�n. Yükseklik grid hücreleri Yükseklik, E� im ve Bak� 
(Elevation, Slope and Aspect) özelliklerine  göre de seçilebilir.  
 
Di� er egzersize ba� lamadan önce TOPO GRID d�� �ndaki tüm tablolar� kapat�n.  
 



Ad�m 8 – Grid Hesaplay�c�n�n (Grid Calculator) Kull an�lmas� 
 
Grid Calculator bir ya da daha fazla gridin eklenmesi, ç�kart�lmas�, çarp�lmas� ya da her grid hücresinin 
sabit bir de� erle bölünmesi, bir gridin di� erinden ç�kart�lmas�, üçüncü bir grid olu� turmak için iki gridin 
de� erlerinin çarp�lmas� gibi aritmetik i� lemlerin yap�lmas�na olanak sa� lar.  
 
Bu egzersizde, bir yükseklik gridinden bir regolit grid baz�n�n ç�kart�lmas�yla regolit kal�nl� � �n� gösteren 
yeni bir grid olu� turaca� �z. Mevcut harita penceresinin üstüne SPOT HEIGHT tablosunu aç�n.  
Regolith_RL alan�n� kullanarak bir grid olu� turmak için önceki ad�mlar� tekrarlay�n. Triangulat ion 
metodunu kullan�n ve ç�kt� gridine BASE_REGOLITH ismini verin.  
 
Surfaces>Grid Calculator seçene� inde TOPO GRID ve BASE_REGOLITH gridlerinin her ikisinide 
açmak için seçin. Her iki gird de diyalogta listelenmelidir. Aritmetik ifade için komut � u � ekilde 
olmal�d�r: 
 
 Newgrid = funtion ( old grid ) 
 
�fademiz BASE_REGOLITH grindin TOPO GRID’den ç�kart�lmas�n�n sonucun veren Regolith ad�nda 
yeni bir grid olu� turacakt�r. EXxpression penceresinin içine klikleyin ve a� a� �dakini ifadeyi yaz�n: 
 
 Regolith =  
 

  Yapt�klar�n�z� kaydetmek için her grid ismini do � ru bir � ekide yaz�n, grid listesinden TOPO 
GRID’i seçin ve Expression alan�na a� a� �daki gibi soldaki tu� u kullanarak grid ismini kopyalay�n: 
 
 Regolith = TOPO_GRID – BASE_REGOLITH 
 

 
 
Compute butonuna klikleyin ve Discover_Tutorial\Surfaces klasörünü görüntüleyin. Yeni bir harita 
penceresinde görüntülenmesi gereken gridi olu� turmak için OK butonuna klikleyin. 
 



  GridInfo arac� kullan�larak grid sorgulanabilir. Surfaces menüsünde bulunan GridInfo butonuna 
klikleyin ve sorgulamak istedi� iniz bir grid alan�na klikleyin. Discover hem seçilen grid hücresinin 
merkezi hem de etraf�ndaki 8 grid hücresi için rapor verir. Esas gridlerle yeni gridde ki grid hücre 
de� erlerini kontrol edin.  
 

 
 

  Grid hücre de� erleri Surfaces>Grid Utilities>Edit menü seçene� i kullan�larak da 
görüntülenebilir. Kayd�rma çubu� unu kullanarak ya da After ön görüntüleme penceresinde solda 
gösterilen imlece klikleyerek TOPO GRID ve BASE_REGOLITH grid hücre de� erlerini görüntüleyin.  
 
Ad�m 9 – Bir Gridi Kesmek 
 
Bir giridin bir parças�n� bir poligon s�n�r�na kesm eye ihtiyaç duyabilirisiniz. Örne� in, sahip oldu� umuz 
TOPO GRID’imizi bir yap� s�n�r�yla kesmek istiyoruz.  
 
Bir bina s�n�r�n� gösteren bir poligonun içeren TENEMENT BOUNDARY tablosunu aç�n. TOPO GRID’i 
içeren harita penceresine ekleyin. TENEMENT BOUNDARY poligonunu seçin. 
 
Surfaces>Grid Utilities>Clip seçene� ini seçin. Grid Clip diyalo� unda tabloyu kesmek için *Selection* 
seçin. GridUtility diyalo� unda grid listesinde TOPO GRID’in seçili oldu� undan emin olun. Clipping 
region listesinden Polygonal ve Action listesinden de Clip grid to region seçenekleri seçilmelidir.  After 
ön görüntüleme penceresinde gridin kesildi� inde nas�l gözükece� i gösterilir.  
 



 
 
Not edelim ki grid, gridin sahip oldu� u bo�  de� erlerin d�� �ndaki alanlarla bina s�n�r� dikdörtgeninin 
minimum s�n�rlanmas�yla kesilecektir.  
 
Save As botununa bas�n, varsay�lan grid ismini kabul edin ve kesilen gridi Discover_Tutorial\Surfaces 
klasörüne kaydedin.  
 
BASE_REGOLITH gridini ve TENEMENT BOUNDARY tablolar�n� içeren yeni bir harita penceresi aç�n. 
Bina s�n�r�n� seçin ve BASE_REGOLITH gridini kesmek için kesme egzersizini tekrarlay�n. Bir sonraki 
egzersizde bina s�n�r� (tenement boundary) içindeki regolit hacmini hesaplamak için bu iki kesilmi�  
gridi kullanaca� �z.  
 
Bu egzersizi tamamlamak için bütün tablolar� kapat�n. 
 
Ad�m 10 – Hacim Hesaplar� 
 
TOPO GRID_CLIPPED ve BASE_REGOLITH_CLIPPED gridlerini bir harita penceresinde aç�n. 
Regolitin hacmini hesaplamak için, Surfaces>Grid Utilities>Grid Volume seçene� ini seçin. Top Grid de 
görüntülemek için TOPO GRID_CLIPPED giridinin üstüne çift t�klay�n. Bottom Grid listesinden 
BASE_REGOLITH_CLIPPED seçin. Sonuç hacim de� eri Computed volume penceresinde 
görüntülenir. De� er hem grid Z ölçe� ine hem de harita birimlerine göredir, bu durumda metredir, bu 
yüzden cevap metre küptür.  
 
Bütün tablolar� kapatarak egzersizi tamamlay�n. 
 
 
 



Ad�m 11 – Noktalardan Alanlara (Voronoi Poligonlar� ) 
 
Nokta verilerden bir Voronoi poligonlar� kümesi olu� turulabilir ve tematik olarak haritalanabilir. Poligon 
s�n�rlar�n�n veri noktalar� aras�nda e � it uzakl�kta yerle� mesiyle her veri noktas� tek bir voronoi poligonu 
için merkez olarak kullan�l�r. Bir veri noktas� de� eri için etki alan�n�n belirlenmesinde voronoi 
poligonlar� kullan�labilir; örne� in mineral kumlar� s�n�fland�rma hesaplamalar�nda. 
 
STREAM SAMPLES tablosunu yeni bir harita penceresinde aç�n. Map>View Entire Layer seçene� in 
seçin ve ELC’yi kullanarak ya da alternatif olarak Query>Select All from Steam Samples sçene� ini 
seçerek tablodaki tüm noktalar� seçin.  
 
Surfaces menüsünden, Surfaces>Create Voronoi Polygons seçene� in seçin. Görünen diyalog 
kutusunda, varsay�lan Output Polygon Table ve varsay�lan Clip polygons to convex hull  seçene� ini 
kabul edin. OK butonuna klikleyin. 
 
Poligonlar� içeren yeni bir katman olu� turulur. Her poligon kendisiyle ilgili bir Cui Pb ve Zn ‘ye sahiptir. 
Bir tematik harita üretimi sonuçlar� görüntülemenize izin verir.  
 
Map>Create Thematic Map seçene� ini seçin. Region Renges Default � ablonunu seçin. Next butonuna 
klikleyin ve POLYGONS OF STREAM SAMPLES tablosunun ve Cu kolonunun seçili oldu� undan emin 
olun. Ignore Zeroes or Blanks kutusunu i� aretleyin ve Next butonuna klikleyin. 
 
Verilen varsay�lan aral�klar istedi� imiz de� ildir. Aral�klar� istedi� iniz gibi ayarlamak için, Ranges 
butonuna bas�n ve Method’u Natural Break olarak seçin. Aral�� � 5 seçin ve OK demeden önce Recalc 
butonuna bas�n. 
 

 
 
Styles botununa bas�n ve her 5 aral�k için bir renk seçin. Önerimiz (dü� ükten yüksek de� erlere do� ru): 
koyu mavi, aç�k mavi, ye� il, sar� ve k�rm�z�. �ki kez OK butonuna klikleyin. 
 



 
 
Tüm tablolar� kapatarak ve Surfaces menüsündeki Exit Surfaces seçene� ini seçerek e� itimi 
tamamlay�n.  
 
 


